MAX1121X Family Evaluation Kit

General Description

The evaluation kit (EV kit) demonstrates the MAX1121X
family of 24-bit, 64ksps delta-sigma ADCs with integrated
PGA. The EV kit includes a graphical user interface (GUI)
that provides communication from the target device to the
PC. The EV kit can operate in multiple modes:

1) Standalone Mode: In “Standalone” mode, the EV
kit is connected to the PC through a USB cable and
performs a subset of the complete EV kit functions
with limitation for sample rate and size.

2) FPGA Mode: In “FPGA” mode, the EV kit is con-
nected to an Avnet ZedBoard™ through a low-pin-
count FMC connector. ZedBoard features a Xilinx®
Zyng®-7000 SoC that connects to the PC through an
Ethernet port, which allows the GUI to perform differ-
ent operations with full control over mezzanine card
functions. The EV kit with FPGA platform performs
the complete suite of evaluation tests for the target IC

3) User-Supplied SPI Mode: In addition to the USB
and FMC interfaces, the EV kit provides two 12-pin
PMOD-style headers for user-supplied SPI interface,
to connect the signals for RDYB, SCLK, DIN, DOUT,
and CSB.

The EV kit includes Windows XP®-, Windows® 7 and
Windows 8.1-compatible software to exercise the features
of the IC. The EV kit GUI allows different sample sizes,
adjustable sampling rates, on-board or external reference
options, and graphing software that includes the FFT and
histogram of the sampled signals with the ability to save
plots in .jpg or .csv formats.

The ZedBoard board accepts a +12V AC-DC wall adapter.
The EV kit can be powered by the ZedBoard or by a local
12V supply. The EV kit has on-board transformers and
digital isolators to separate the IC from the ZedBoard/
on-board processor.

The MAX11214 EV kit comes installed with a
MAX11214EUG+ in a 24-pin TSSOP package and the
MAX11216 EV kit comes installed with a MAX11216EUG+
in a 24-pin TSSOP package.
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Evaluates: MAX11214/MAX11216

Features and Benefits

e High-Speed USB, FMC Connector, and PMOD
Connector

e 5MHz SPI Interface
e Various Sample Sizes and Sample Rates
e Collects Up to 1 Million Samples (with FPGA Platform)

e Time Domain, Frequency Domain, and Histogram
Plotting

e Save Plots as jpg, bmp or csv

e Sync In and Sync Out for Coherent Sampling
(with FPGA Platform)

e On-Board DAC (MAX542) for DC Signal-Level
Generation

e On-Board Voltage Reference (MAX6126)
e Proven PCB Layout
e Fully Assembled and Tested

e Windows XP-, Windows 7-, and Windows
8.1-Compatible Software

e Savable ADC Configurations

Ordering Information appears at end of data sheet.

ZedBoard is a trademark of Avnet, Inc.

Xilinx and Zynq are registered trademarks and Xilinx is a regis-
tered service mark of Xilinx, Inc.

Windows and Windows XP are registered trademarks and reg-
istered service marks of Microsoft Corporation.
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MAX1121X Family Evaluation Kit

MAX1121X EV Kit Files

FILE DECRIPTION

Application Program

MAX11214_16EVKitSetupV1.1.exe (GUI)

Boot.bin ZedBoard Firmware

(SD Card to boot Zynq)

Quick Start

Required Equipment

o MAX1121X EV kit

e +12V (500mA) power supply
e Micro-USB cable

e ZedBoard development board (optional — Not Included
with EV kit)

e Function generator (optional)

e Windows XP, Windows 7, or Windows 8.1 PC with a
spare USB port

Note: In the following sections, software-related items are
identified by bolding. Text in bold refers to items directly
from the EV system software. Text in bold and underline
refers to items from the Windows operating system.

Procedure

The EV kit is fully assembled and tested. Follow the steps
below to verify board operation:

1) Visit www.maximintegrated.com/evkitsoftware to
download the latest version of the EV kit software,
MAX11214_16EVK.ZIP. Save the EV kit software to a
temporary folder and uncompress the ZIP file.

2) Installthe EVkitsoftwareand USBdriveronyourcomput-
er by running the MAX11214_16EVKitSetupV1.1.exe
program inside the temporary folder. The program
files are copied to your PC and icons are created in
the Windows Start | Programs menu. At the end of
the installation process, the installer will launch the
installer for the FTDIChip CDM drivers.

For Standalone mode:

3) Verify that all jumpers are in their default positions for
the EV kit (Table 2).

4) Connect the PC to the EV kit using a micro-USB
cable.

5) Connect the +12V adapter to the EV Kkit.

6) Start the EV kit software by opening its icon in the
Start | Programs menu. The EV kit software appears
as shown in Figure 1. Verify that the lower left status
bar indicates the EV kit hardware is Connected.

www.maximintegrated.com
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7) From the Device menu, select Standalone and click
Search for USB Device. Then select Standalone
again and select a device in the list. Verify that the
lower left status bar indicates the EV kit hardware is
Connected.

For FPGA mode (when connected to a ZedBoard):

8) Connect the Ethernet cable from the PC to the
ZedBoard and configure the Internet Protocol Version
4 (TCP/lpv4) properties in the local area connec-
tion to IP address 192.168.1.2 and subnet Mask to
255.255.255.0.

9) Verify that the ZedBoard SD card contains the
boot.bin file for the MAX1121X EV Kkit.

10) Connect the EV kit FMC connector to the ZedBoard
FMC connector. Gently press them together.

11) Verify that all jumpers are in their default positions for
the ZedBoard (Table 1) and EV kit (Table 2).

12) Connect the 12V wall adapter power supply to the
ZedBoard. Leave the ZedBoard powered off. Connect
the PC to the ZedBoard with an Ethernet cable.

13) Enable the power supply by sliding SW8 to ON.

14) Start the EV kit software by opening its icon in the
Start | Programs menu. The EV kit software appears
as shown in Figure 1. From the Device menu, select
FPGA. Verify that the lower left status bar indicates
the EV kit hardware is Connected.

For either Standalone or FPGA mode:

15) Connect the positive terminal of the function generator
to the IN+ test point on the EV kit. Connect the nega-
tive terminal of the function generator to the IN- test
point on the EV kit. Disable the function generator.

16) Enable the function generator. Configure the signal
source to generate a 1kHz, 1Vp_p sinusoidal wave
with +500mV offset.

17) In the Calibration group, select Self Offset/Gain in
the drop-down list and then click Calibrate.

18) Click on the Scope tab.

19) Check the Remove DC checkbox to remove the DC
component of the sampled data.

20) Click the Capture button to read sampled data from
the ADC.

21) The EV kit software appears as shown in Figure 4.

22) Verify the frequency is approximately 1kHz displayed
on the right. The scope graph has buttons in the
upper-right corner that allow zooming in to detail.

Maxim Integrated | 3
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Table 1. ZedBoard Jumper Settings (Optional)

SHUNT
JUMPER POSITION DESCRIPTION
J18 1-2 VDDIO set for 3.3V
JP11 2-3
JP10 1-2
JP9 1-2
Boot from SD card
JP8 2-3
JP7 2-3
JP10 —
J12 — SD card installed
J20 — Connected to 12V wall adapter
SW8 Off ZedBoard power switch, off while connecting boards
Table 2. MAX1121X EV Kit User Configuration Jumper Settings*
SHUNT
JUMPER POSITION DESCRIPTION
J2 (Red) 1-2 Connects the +10V rail to test point +10VEXT for external power (op amp + supply)
2-3* Connects the +10V rail to LDO U2 (op amp + supply)
J3 (Red) 1-2 Connects the +15V rail to test point +15EXT for external power (powers U2)
2-3* Connects the +15V rail to isolation transformer (powers U2)
1-2 Set ADC DVDD to +3.3V
J4 (Red)
2-3* Set ADC DVDD to +2.0V
35 (Red) 1-2* Connect ADC AVSS to GND (unipolar mode — also set J8 for unipolar)
2-3 Connect ADC AVSS to -1.8V (bipolar mode — also set J8 for bipolar)
1-2 Apply an offset of ADC_REFP (2.5V default) to amplifier U24
J6 (Black) 2-3 Apply an offset of 2.5V to amplifier U24
Open* No offset for amplifier U24
1-2 Apply an offset of ADC_REFP (2.5V default) to amplifier U27
J7 (Black) 2-3 Apply an offset of 2.5V to amplifier U27
Open* No offset for amplifier U27
J8 (Red) 1-2 Connect ADC AVDD to +1.8V (bipolar mode)
2-3* Connect ADC AVDD to 3.6V (unipolar mode)
15 (Red) 1-2* Connects ZedBoard +12V to main power supply (U3). Diode D2 protects supplies.
Open Disconnects ZedBoard +12V from main power supply
1-2 Connects U5 input to GND
J17 (Red) 3-4 Connects U5 input to test point -15VEXT for external power
5-6* Connects U5 input to isolation transformer
1-2 Do not connect
J18 (Red) 3-4 Do not connect
5-6 Connects U5 output to GND, which sets the reference for the -10V supply (op amp - supply)
120 (Red) 1-2* Connects on-board FTDI chip to 3.3V, necessary for standalone mode
Open Disconnects on-board FTDI chip power. This jumper does not interfere with the ZedBoard.
421 (Black) 1-2¢ Drive ADC REFP pin with on-board voltage reference
2-3 Drive ADC REFP pin with external voltage reference

www.maximintegrated.com Maxim Integrated | 4



MAX1121X Family Evaluation Kit

Table 2. MAX1121X EV Kit User Configuration Jumper Settings* (continued)

JUMPER P(S)|;|L'1|'T(IN DESCRIPTION
1-2 Ground test point CH_D-
J22 (Black) 3-4 Ground test point CH_D+
123 (Black) 1-2* Drive ADC REFN pin with on-board voltage reference
2-3 Drive ADC REFN pin with external voltage reference
124 (Black) 1-2 Ground test point CH_C-
3-4 Ground test point CH_C+
1-2¢ Connect output of U23 (CH_C) to U24 inverting input
125 (Black) 3-4 Connect CH_D- to U24 inverting input
5-6 Connect output of U23 (CH_C) to U24 noninverting input
7-8 Connect CH_D+ to U24 noninverting input
1.0 Set bot_h jumpers to align with silkscreen text “EXT” tp drive ADC_INP and ADC_INN with
test points IN+ and IN- (also external connector J10 is on same net)
3-4 Set both jumpers to align with silkscreen text “AMP” to drive ADC_INP and ADC_INN with U27 and
U24 amplifiers
J(?B?ailf; 5-6 Set both jumpers to align with silkscreen text “DAC” to drive ADC_INP and ADC_INN with DAC_
OUT+ and DAC_OUT-
7.8 Set both jumpers to align with silkscreen text “REF” to drive ADC_INP and ADC_INN with ADC_
REFP and ADC_REFN voltage reference
9-10 ADC_INP to ADC_REF/2, ADC_INN to GND
128 (Black) 1-2 Ground test point CH_A-
3-4 Ground test point CH_A+
1-2* Connect output of U26 (CH_A) to U27 inverting input
129 (Black) 3-4 Connect CH_B- to U27 inverting input
5-6 Connect output of U26 (CH_A) to U27 noninverting input
7-8 Connect CH_B+ to U27 noninverting input
130 (Black) 1-2 Ground test point CH_B-
3-4 Ground test point CH_B+
136 (Black) 1-2 Drive ADC CLK pin with signal from SMA connector J34
2-3* Drive ADC CLK pin with signal from on-board oscillator U20
137 (Red) 1-2¢ Connect ADC to the DVDD voltage selection jumper J4
open Attach amp meter between pins 1-2 to measure current consumed by ADC DVDD
140 (Black) 1-2* Connect ADC RST to DVDD (normal operation)
2-3 Connect ADC RST to GND (reset state)
144 (Black) 1-2* Sets U18 noninverting input to 0V. Gain = -1 with offset = 0. Drives DAC_OUT-.
2-3 Sets U18 noninverting input to 2.5V. Gain = -1 with offset = 2.5V. Drives DAC_OUT-.
145 (Black) 1-2* Sets U17 noninverting input to 0V. Gain = -1 with offset = 0. Drives DAC_OUT+.
2-3 Sets U17 noninverting input to 2.5V. Gain = -1 with offset = 2.5V. Drives DAC_OUT+.
146 (Red) 1-2* Enables main power supply (U3)
Open Disables main power supply (U3)

*Red test points and red jumpers are used for power settings.
Black test points are used for ground points.
White test points are used for all signal points, black jumpers for signal settings.

www.maximintegrated.com
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Evaluates: MAX11214/MAX11216

Table 3. MAX1121X EV Kit User Off-Board Connectors

CONNECTOR
REFERENCE DESCRIPTION
DESIGNATOR

J1 USB connector for standalone mode

J9 External reference input for EXT_REFP and EXT_REFN

J10 External input for ADC IN+ and IN-

412, 416 External power connections, 12V. Both walll gdapter and .sc.rew terminals are provided. When ZedBoard is
used, these connectors are not necessary if jumper J15 is installed.

J13 External connections for AVYDD and AVSS

J14 External enable, driven by GPIO1 via FET

J19 Serial EEPROM signal

J31 Sync clock input, SMA

J32 PMOD A, connects to ADC, 12-pin connector

J33 PMOD B, connects to DAC, 12-pin connector

J34 External clock input, SMA

J35 DAC SPI port signal

J38, J41 Sync clock out, SMA

J39 ADC SPI port signal

Ja2 Split sync clock in, SMA

J43 FMC connector for use with ZedBoard

General Description of Software

The main window of the EV kit software contains sev-
eral tabs: ADC Config, DAC Config, Function Generator,
Scope, DMM, Histogram, FFT, and ADC Registers. The
ADC Config tab and ADC Registers tab provide control
to communicate with the MAX1121X registers. The DAC
Config tab and Function Generator tab provide control to
communicate with the MAX542. The other four tabs are
used for evaluating the sample data read from the ADC.

ADC Config Tab

The ADC Config tab provides an interface for configur-
ing the IC from a functional perspective. The main block
provides for calibration, GPIO control, input path selec-
tion, data format, filtering, power, and clocking. To read
all the configuration settings, click the Read All button in

www.maximintegrated.com

the Serial Interface block. When a setting is changed,
the register associated with that setting is automatically
written. The Status Log at the bottom of the GUI shows
the value and register that was changed.

The primary mode for calibration is using the drop-down
list to select a calibration mode, followed by clicking the
Calibrate button. The checkboxes for Self Offset, Self
Gain, System Offset, and System Gain allow for the
user to enable or disable the calibration values. The cali-
bration values can also be changed manually by entering
a hex value in the SPI numeric box.

The Power block allows the user to put the part in a
power-down or standby state by selecting one of these
options in the drop-down list. The configuration set-
tings can be reset back to default by clicking the Reset

Maxim Integrated | 6



MAX1121X Family Evaluation Kit

Registers button. For the Clock source selection, the IC
internal clock is always a valid option. If the external clock
is selected, a clock must be applied at the IC CLK pin by
setting jumper J36 to either SMA or OSC. Once the above
configurations are completed, start conversion by clicking
Convert in the Serial Interface block. To read the data
and status, click Read Data and Status on the lower right
of the GUI.

Evaluates: MAX11214/MAX11216

To save a configuration, select Save ADC Config As...
in the File menu. This saves all the ADC register values
to an XML file. To load a configuration, select Load ADC
Config in the File menu. When the XML file is loaded, all
the register values in the file are written to the ADC.

() 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit = | B ||
File  Device QOptions Help
ADC Config | DAC Config | Function Generator Scope | DMM Histogram FFT ADC Registers
Sample Rate (SPS) Calibration GPIO Data (V) Data (Hex)
1000 - MAX 11214 v 2.499919 TFFEF1
Self Offset/Gain - Calibrate GPIO1T  ~
Number of Samples [Check to Enable)  SPl(hex) ADC {hex) Direction Sample Rate (SPS)
2048 = / Self Offset 0 I 000000 nput__ | - 1000
: +
Reference Voltage (V) + Self Gain BF851B _ BF851B Value Power State
250 + System Offset 0 % 000000 ADC Converting
Input Path System Gain TFFFFF © 7FFFFF
New C ion Read
Direct ¥ Delta-Sigma Modulator Digital Filters Serial Interface o ew Lomversion Ready
Data Format SINC . O Modulator Busy
— Bipolar v O No Data Overrange
. Canvert
DGAN | #'s Compliment | ~ O No Sys Gain Overrange
1 |, |24t B g ->
Read All O No Analog Overrange
Conversion Mode
Continuous . O No Data Read Error
No E
Power Clock O o e
Not In Reset
Internal v O
| MNormal v
L SYNC Mode
Reset Registers Pulse .
I Read Data and Status
I Status Log Clear Log I
IC: MAX11214 EV Kit Software Version 1.0 EV Kit Hardware Connected

Figure 1. MAX1121X EV Kit Software (ADC Config Tab)
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MAX1121X Family Evaluation Kit

DAC Config Tab

In standalone mode, the ADC and DAC cannot oper-
ate concurrently. It is recommended to use FPGA
mode when using the DAC for function generation.
The DAC Config tab sheet provides an interface for
configuring the MAX542 to drive the DAC_OUT+ and
DAC_OUT- pins. Set J45 Offset and J44 Offset to match
the jumper positions on the EV Kit. These jumper posi-
tions apply DC offset to DAC_OUT+ and DAC_OUT-,
see the DAC amplifier section for more details. To write a
value to the DAC, select the output of interest in the drop-
down list, enter a value in the numeric box and then click
DAC Single Shot. The outputs on the right display the
voltage outputs and the decimal code written to the DAC.

Evaluates: MAX11214/MAX11216

The voltage outputs are calculated based on the DAC
code and jumper offsets.

The Calibration section of the DAC Config tab can be
used to calibrate the calculated voltages to be closer to
the measured voltages. Select which output to calibrate
with the radio buttons. Enter the maximum and minimum
voltage for this output in the Ideal (V) numeric boxes. Find
the measured voltages of the output for the maximum
and minimum values using the DAC Single Shot to set
the DAC output to the ideal voltages. Enter the measured
voltages in the Measured (V) numeric boxes and click
Calculate to find the new offset and gain. Check the
Enable Calibration to use these values to calculate the
voltage outputs.

() 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit _=--E|--‘3—
File  Device Options Help
ADC Config | DAC Config | Function Generator Scope | DMM | Histogram | FFT ADC Registers
Reference Voltage (V) DAC_OUT+ (V) DAC_OUT- (V) |
2.50 VREF 0 0 [
J45 Offset c Differential DAC_OUT (V)
REFF REFS - Uig
s GND VREF " — 0
MAX9E32 (R}
DAC . DAC DIN Code (hex)
J44 Offset MAX542 - u17
45 LR DAC_OUT+ 0
« GND VREF 4 MAX9832 R} O
VREF (R} + c Calibration
Differential DAC_OUT
Herena = i\ C H (R} Enable Calibration
& u1g
SuLLL I " (R} DAC_OUT- ® DAC_OUT+ DAC_OUT-
! MAxgs32
r‘ﬂ Ideal (V) Measured (V)
VREF (R} + Max| 25 * | 250000 *
c H Min = 25 * | 250000 *
I Calculate
Offset (mV)
0.000000 :
Gain Value
DAC Single Shot 1.000000
Status Log Clear Log
IC: MAX11214 EV Kit Software Version 1.0 EV Kit Hardware Connected

Figure 2. MAX1121X EV Kit Software (DAC Config Tab)
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Function Generator

When using the FPGA mode, the Function Generator
tab allows the user to generate a signal with the DAC.
Select the Number of Samples, DAC Update Rate, and
Signal Frequency. Click Calculate to get the Adjust
Frequency for the DAC signal needed for coherent sam-
pling. Then select the Signal Type, Amplitude, Phase, and
Offset to set up the waveform desired for the DAC. Click

Evaluates: MAX11214/MAX11216

Generate to find the DAC codes for the waveform and
generate the waveform on the DAC. The waveform codes
sent to the DAC is displayed on the graph. The Average,
RMS, Maximum, Minimum, and Peak to Peak are also
calculated and displayed on the right. To save the DAC
code waveform, go to Options > Save Graph > Function
Generator. This saves the settings on the left and the
data in the graph to a csv file.

(@ 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit O |
m— =
File Device Options Help
ADC Config | DAC Config | Function Generator | Scope | DMM | Histogram | FFT ADC Registers
Number of Samples Average (LSB)
8192 v | Channels 32767.5001
50000 — Channel 1
DAC Update Rate [Hz) eI i AMS (LSB)
299850.063 = ) I 19868.4634
45000 -{ ' ,
| Signal Freguency (Hz) 42500 Maximum (LSB)
500.000 2 40000 49152
& 37500
I Adjusted Frequency (Hz) 2 22000 Minimum (LSB)
I 622.247 ] 16384
S 22500
I Calculate ?;L 30000+ Peak to Peak (LSB)
<f 27500 32768
Signal Type 25000
| Sine v 22200
amo ] HATY |
Ampltuds (LSB) I T VAL L
+ 17500
| 16384 & - ¥ L ¥ ¥ v ¥
15000 ‘ |
Phase (degfees} T T T T T T T T T T T T T T T T T
0 = 0 500 1000 1500 2000 2500 3000 3500 4000 4500 5000 S500 6000 €500 7000 7500 2000
Sample Number
| Offset [LSB)
I 32768 e Generate
Status Log | ClearLog |
i
|
IC: MAX11214 EV Kit Software Version 1.0 EV Kit Hardware Connected

Figure 3. MAX1121X EV Kit Software (Function Generator Tab)
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Scope Tab

The Scope tab sheet is used to capture data and dis-
play it in the time domain. Sample Rate and Number
of Samples can also be set in this tab if they were not
appropriately adjusted in other tabs. The Display Unit
drop-down list allows counts and voltages. Once the
desired configuration is set, click on the Capture button.
The right side of the tab sheet displays details of the wave-

Evaluates: MAX11214/MAX11216

form, such as Average, Standard Deviation, Maximum,
Minimum, and Fundamental Frequency. Figure 4 displays
the ADC data when a sinusoidal signal is applied at the
inputs on the EV Kkit.

To save the captured data to a file, go to Options > Save
Graph > Scope. This saves the setting on the left and the
data captured to a csv file.

Sample Rate (SPS)

() 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit _
Eile Device Options Help
ADC Config | DAC Config | Function Generator Scope | DMM Histogram FFT ADC Registers

Status Log

Estimated Capture Time: 0.26s
Reading...Capture complete
Estimated Capture Time: 2.058s
Reading...Capture complete

IC: MAX11214

I Average I
jaon N Channels 0.0071V
AT W =
Number of Samples 0.304 Standard Deviation
2048 v 0.6583 V
0.60
Display Unit Maximum
v v 0409 0.9393 V
Average Samples 0204 Minimum
1 B s 0.9243V
£ o000 |
Resolution Selection E' Fundamental Frequency (Hz)
o -0.20
24 v 29.8
0.40
Remove DC Offset
0.60
L I INNERIE R B |
r T T T T T T T T T T T
o S0 100 150 200 250 300 350 400 450 soo 550

Sample Number

| Capture

EV Kit Software Version 1.0

Clear Log

EV Kit Hardware Connectad

Figure 4. MAX1121X EV Kit Software (Scope Tab)
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DMM Tab by the DMM tab when ADC_INP and ADC_INN (J26 and
The DMM tab sheet provides captured data as a digital J27 set as 7-8) are set to REF, see Table 2 for jumper
multimeter. Once the desired configuration is set, click on positions.

the Capture button. Figure 5 displays the results shown

(@) 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit = | B ||

File  Device Options Help

ADC Config | DAC Config | Function Generator Scope | DMM | Histogram | FFT ADC Registers

Sample Rate (SPS) Maximum
1000 - Average 2.4999 V
Number of Samples Minimum
e 2.4999 Vv o

.
Display Unit Fundamental Frequency (Hz)
vV = 165.0

Standard Deviation Before Averaging

Average Samples
1 v

0.0000 \Y

24 v

Remove DC Offset Standard Deviation After Averaging

0.0000 V

I Capture

Status Log Clear Log

IC: MAX11214 EV Kit Software Version 1.0 EV Kit Hardware Connected

Figure 5. MAX1121X EV Kit Software (DMM Tab)
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Histogram Tab

The Histogram tab sheet is used to display a histogram of
the captured data. Sampling rate and number of samples
can also be set in this tab if they were not appropriately
adjusted in other tabs. Once the desired configuration is
set, click on the Capture button. The right side of the tab
sheet displays details of the histogram such as Average,
Standard Deviation, Maximum, Minimum, Peak-to-Peak

Evaluates: MAX11214/MAX11216

Noise, Effective Resolution, and Noise-Free Resolution.
To use this histogram feature, apply a DC voltage at the
input. Figure 5 displays the results shown by the DMM tab
when ADC_INP and ADC_INN are set to REF, see Table
2 for jumper positions.

To save the histogram data to a file, go to Options > Save
Graph > Histogram. This saves the setting on the left
and the histogram data captured to a csv file.

Eile Device QOptions Help

ADC Config | DAC Config | Function Generator Scope | DMM Histogram | FFT

Sample Rate (SPS)
1000 v

Disable Histogram

-
(X 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit ‘ —

ADC Registers

T ==

Average (LSB)
8388336.7

1204

Channels

Number of Samples

== Channel 1

Standard Deviation (LSB)

2048 v

1004

Average Samples 504
1 v

Resolution Selection
24 v

Occurrence

Remove DC Offset

8.0

Maximum (LSB)

8388363

Minimum (LSB)
8388310

Peak to Peak Noise (LSB)
53.0

Effective Resolution (Bits)
7.0

Noise Free Resolution (Bits)
18.3

T T T
8388310.0 8388320.0 8388330.0

Display
Auto v

Status Log

T T T
8388340.0 8388350.0 8388360.0
Amplitude (LSB)

Capture

| ClearLog |

IC: MAX11214

EV Kit Software Version 1.0

EV Kit Hardware Connected

Figure 6. MAX1121X EV Kit Software (Histogram Tab)
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MAX1121X Family Evaluation Kit

FFT Tab

The FFT tab sheet is used to display the frequency domain
FFT of the captured data. Sample Rate and Number of
Samples can also be set in this tab if they were not appro-
priately adjusted in other tabs. Once the desired configura-
tion is set, click on the Capture button. The right side of

Evaluates: MAX11214/MAX11216

the tab displays the performance based on the FFT, such
as Fundamental Frequency, THD, SNR, SINAD, SFDR,
ENOB, and Noise Floor.

To save the FFT data to a file, go to Options > Save
Graph > FFT. This saves the setting on the left and the
FFT data captured to a csv file.

) 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit | S |
File  Device Options Help
ADC Config | DAC Config | Function Generator Scope | DMM Histogram FFT ADC Registers
Sample Rate (SPS) Fundamental Frequency (Hz)
1000 - 0 Channels 33
-104 == Channel 1
MNumber of Samples 20 SNR (dB)
2048 - 204 176
Average Samples -0 SINAD (dB)
1 - =1 162
50
Resolution Selection E 704 THD (dB)
24 - S -8 1216
£ 904
Window Function E‘ -1004 SFDR (dB)
None A < _t10 123.3
-1204
1304 | . ENOB (Bits)
1204 19.0
R
Moise Floor (dB)
-160
147.7
1704
T T T T T T T T T T
0.000 0.050 0100 0.150 0.z00 0.250 0.300 0.350 0.400 0.450
kHz
Capture |
Status Log Clear Log
Estimated Capture Time: 2.05s -
Reading.. Capture complete
Estimated Capture Time: 2.05s
Reading.. Capture complete
IC: MAX11214 EV Kit Software Version 1.0 EV Kit Hardware Connected

Figure 7. MAX1121X EV Kit Software (FFT Tab)

www.maximintegrated.com
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MAX1121X Family Evaluation Kit

ADC Registers Tab

The ADC Registers tab sheet shows the ADC registers
on the left. The middle section shows the bits and bit
descriptions of the selected register. Click Read All to
read all registers and refresh the window with the register
settings. To write a register first, select the hex value in
the Value (Hex) column, type the desired hex value and
press Enter.

Evaluates: MAX11214/MAX11216

The Command Byte is on the right side of the tab sheet.
This byte precedes all SPI transactions and is described
in the ADC data sheet. To send a command byte, enter a
hex value in the Numeric box and click the Send button.
The command byte has two different formats including
Conversion Mode and Register Access Mode. Select the
radio button for the desired mode to see the bit descrip-
tion in the table.

(@) 24-bit, 32/64ksps Delta-Sigma ADC MAX11214/16 EV Kit = | B ||
File  Device Options Help
ADC Config | DAC Config | Function Generator Scope | DMM || Histogram | FFT ADC Registers
Registers Command Byte
+ I
Read All Bit Description. STAT Register 0 *h ® Conversion Mode
Address Register Value (Hex) Bit Name Description Send Register Access Mode
m STAT 30A3 B[0] RODY Ready: 1= new conversion result is ready i Bit Name Description
01h CTRL1 00 B[1] MSTAT Measurement S-tatL_ls, 1 = modulator is busy measuring BE:0] RATE[3.0] |Data Rate for canversion
02h CTRL? 00 B[2] DOR Data Overra.nge. 1= datfa ou_t of range i 7 D 1= sleep mode
03h CTRL3 51 B[3] SYSGOR  System Gain Overrange: 1 = system gain out of range 0 = normal
04h CTRLY 08 B[7:4] RATE[3:0] Data Rate: Data rat.e of previous conversion BE5] CAL 1 f perform ca_hbration
B[8] ADR Analog Qverrange: input voltage > 1.3 x full scale 0 = no calibration
oy Ok 1L B[9] RDERR Data Read Error: 1 = data read while data written MODE = 0'to start
06h DATA TFFEES00 Power Status B[6] MODE conversion, power down
07h S0C_SPI 000000 00 = ADG is converting or calibrate
— B[11:10] PSTAT[1:0] ) _ -
08h SGC_SPI TFFFFF 01 = powered down B[7] START START =1
= 10 = standby
09h SCOC_SPI 000000 B[13:12] Reserved
0Ah SCGC_SPI BFe51B B[14] ERROR Error: 1= CAL[1:0] set to invalid setting of 11
0Bh HPF 0332 B[15] INRESET In Reset: 1= part is in reset mode
15h SOC_ADC 000000
16h SGC_ADC TFFFFF
17h SCOC_ADC 0000sc
16h SCGC_ADC CBFF1D
Naote: double click "Value" column to edit
Status Log Clear Log
IC: MAX11214 EV Kit Software Version 1.0 EV Kit Hardware Connected

Figure 8. MAX1121X EV Kit Software (ADC Registers Tab)
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MAX1121X Family Evaluation Kit

Detailed Description of Hardware

This EV kit provides a proven layout to demonstrate the
performance of the MAX1121X 24-bit delta-sigma ADC.
Included in the EV kit are digital isolators (MAX14934),
ultra-low-noise LDOs (MAX8842) to all supply pins of
the IC, an on-board reference (MAX6126), a precision
amplifier (MAX44241) for the analog inputs, 16-bit DAC
(MAX542) with precision amplifiers (MAX9632), and sync-
in and sync-out signals for coherent sampling.

An on-board controller is provided to allow for evaluation
in standalone mode, which has limitations on maximum
sample size and it cannot perform coherent sampling.
The EV kit can be used with FPGA mode to achieve larger
sample depth and coherent sampling.

The ADC has several input options which are selected by
J26 and J27. The external option allows for wires attached
to the screw terminals at J10. The amplifier option allows
for signals at testpoints CH_A to CH_D. The DAC option
allows for inputs to be driven from an on-board DAC. The
REF options connect the inputs to the voltage reference
of the ADC.

User-Supplied SPI

To evaluate the ADC on this EV kit with a user-supplied
SPI bus, disconnect from the FMC bus and remove
jumper J20. Apply the user-supplied SPI signals to SCLK,
CSB, DIN, and DOUT at the PMOD_A header (J32).
Make sure the return ground is connected to PMOD
ground. To communicate to the on-board DAC connect
the user-supplied SPI signals to CSB, SCLK, DIN, and
LDAC at the PMOD_B header (J33). Make sure the return
ground is connected to PMOD ground.

The on-board FTDI chip used for standalone mode does
not conflict with the user-supplied SPI if it is powered off
by removing jumper J20.

Caution: Do not plug this header into a standard PMOD
interface found on other FPGA or microcontroller prod-
ucts. The signal definition is unique to this EV kit.

User-Supplied Reference

For user-supplied reference voltage, set jumpers at J21
and J23 to positions 2-3 and apply external reference to
either J9 or to the EXT_REFN and EXT_REFP testpoints.

User-Supplied AVSS

The AVSS supply is set to GND or -1.8V by Jumper J5.
For user-supplied AVSS, remove the jumper from J5 and
apply AVSS to the screw-terminals/testpoint at J13. Make
sure that this external supply has the correct relation to
system ground.

www.maximintegrated.com
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User-Supplied AVDD

The AVDD supply is set to 3.6V or 1.8V by jumper J8.
For user-supplied AVDD, remove the jumper from J8 and
apply AVDD to the screw-terminals/testpoint at J13. Make
sure that this external supply has the correct relation to
system ground.

Bipolar Powered vs. Unipolar Powered

The ADC supports both unipolar and bipolar ranges. For
unipolar mode, jumper J8 pins 2-3 to power AVDD with
3.6V and jumper J5 pins 1-2 to set AVSS to GND. For
bipolar mode, jumper J8 pins 1-2 to power AVDD with
1.8V and jumper J5 pins 2-3 to set AVSS to -1.8V.

External Clock

When the ADC is configured to use an external clock,
Jumper J36 pins 2-3 to select the on-board oscillator as
the clock source. Jumper J36 pins 1-2 to select the SMA
connector (and user-provided clock) as the clock source.

GPIO

Testpoints are provided for the three GPIO signals from
the ADC, GPIO1, GPIO2, and GPIO3. The ADC Config
tab can configure these as input/output and read/drive the
GPIO pins. GPIO1 connects to a FET which allows J14.1
and TP2 to be connected to ground by driving GPIO1 high
(note that DVDD should be to 3.3V to drive the FET).

ADC Input Amplifiers

The input amplifiers allow for significant flexibility. The
amplifier input stage begins with testpoints labeled CH_A
to CH_D. Each set of testpoints has options to ground
either the inverting or noninverting inputs. The jumper
block J29 and J25 allow for bypassing the first stage of
amplifiers, or connecting the first stage to the second
stage. Jumper J7 can provide an offset of 2.5V to the
CH_A/CH_B signals — leave unpopulated to have an
offset of OV. Similarly, jumper J6 can provide an offset of
2.5V to the CH_C/CH_D signals — leave unpopulated to
have an offset of OV.

DAC and DAC Amplifiers

In Figure 2, the GUI shows a functional diagram of the
DAC and DAC amplifiers. Here jumper J45 can be con-
nected to 2.5V to add a 2.5V offset to the DAC_OUT+
signal, and J44 can be connected to 2.5V to add 2.5V to
the DAC_OUT- signal.

The value at DAC_OUT+ and DAC_OUT- are available to
drive to the ADC by use of jumpers J26 and J27.

Also, please note that the DAC_OUT+ and DAC_OUT-
values shown by the GUI are only valid if the settings at
J44 and J45 are the same on both the PCB and the GUI.

Maxim Integrated | 15



MAX1121X Family Evaluation Kit

Evaluates: MAX11214/MAX11216

Mo

-]

MAX44241
+
CH_B-
O .
CH_B+
[l
I
MAX44241

+

N_q

L]

N+
1 ADC_INP
MAX44241 8
o
DAC_OUT+ §
N ADC_REFP 7
ADC_REF2 9
ADC_REFP
N-
1 ADC_INN
3
MAX44241
DAC.OUT- 5
+ ADC_REFN 7
9
ADC_REFP

MAX11214/MAX11216

Sigma-Delta ADC

Figure 9. Analog Front-End
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MAX1121X Family Evaluation Kit

Table 4. Analog Input Configurations (Ch A - D)

Evaluates: MAX11214/MAX11216

CONFIGURATION

No.

DESCRIPTION

SIGNAL-PATH INPUT
CONFIGURATION

INPUT CONNECTORS

JUMPER POSITIONS

ChannelAand C

Noninverting, differential,
second-order LPF
(default)

CH_A-and CH_C-

J28: 3-4
J30: 3-4
J24: 3-4
J22: 3-4
J29: 1-2 and 7-8
J25:1-2 and 7-8
J26: 3-4
J27: 3-4
J7: 1-2 (for bipolar signal) or
Open for unipolar signal
J8: 1-2 (for bipolar signal) or
Open for unipolar signal

ChannelAand C

Inverting, differential,
second-order LPF

CH_A+and CH_C+

J28: 1-2
J30: 3-4
J24:1-2
J22: 3-4
J29:1-2 and 7-8
J25:1-2 and 7-8
J26: 3-4
J27: 3-4
J7: 1-2 (for bipolar signal) or
Open for unipolar signal
J8: 1-2 (for bipolar signal) or
OPEN for unipolar signal

Channel B and D

Noninverting, differential,
first-order LPF

CH_B+and CH_D+

J28: 1-2 and 3-4
J30: 1-2
J24:1-2 and 3-4
J22: 1-2
J29: 3-4 and 7-8
J25: 3-4 and 7-8
J26: 3-4
J27: 3-4
J7: 1-2 (for bipolar signal) or
Open for unipolar signal
J8: 1-2 (for bipolar signal) or
Open for unipolar signal

Channel B and D

Inverting, differential, first-
order LPF

CH_B-and CH_D-

J28: 1-2 and 3-4
J30: 3-4
J24:1-2 and 3-4
J22: 3-4
J29: 3-4 and 7-8
J25: 3-4 and 7-8
J26: 3-4
J27: 3-4
J7: 1-2 (for bipolar signal) or
Open for unipolar signal
J8: 1-2 (for bipolar signal) or
Open for unipolar signal

www.maximintegrated.com
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Table 4. Analog Input Configurations (Ch A - D) (continued)

CONFIGURATION

No.

DESCRIPTION

SIGNAL-PATH INPUT
CONFIGURATION

INPUT CONNECTORS

JUMPER POSITIONS

External Inputs

User-supplied signals

IN+ and IN-

J28: 1-2 and 3-4
J30: 1-2 and 3-4
J24:1-2 and 34
J22:1-2 and 3-4
J29: 3-4 and 7-8
J25: 3-4 and 7-8
J26: 1-2
J27:1-2
J7: Open
J8: Open

DAC Output

DAC output buffered with
MAX9632

DAC_OUT+ and DAC_
ouT-

J28: 1-2 and 3-4
J30: 1-2 and 3-4
J24:1-2 and 3-4
J22: 1-2 and 3-4
J29: 3-4 and 7-8
J25: 3-4 and 7-8
J26: 5-6
J27: 5-6
J7: Open
J8: Open

ADC Voltage Reference

Voltage reference input
to ADC from MAX6126 or
external source (see J21

and J23)

ADC_REFP and ADC_
REFN

J28: 1-2 and 3-4
J30: 1-2 and 3-4
J24: 1-2 and 3-4
J22:1-2 and 3-4
J29: 3-4 and 7-8
J25: 3-4 and 7-8
J26: 7-8
J27:7-8
J7: Open
J8: Open

www.maximintegrated.com
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Figure 10a. MAX1121X EV Kit Schematic (Sheet 1 of 6)
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www.maximintegrated.com Maxim Integrated | 20



MAX1121X Family Evaluation Kit Evaluates: MAX11214/MAX11216

o> USB+5V

— (W] +3.3VU_USB

o> GND

a
T« T os
oqo 19 Y £ o
aoaa a a Lo o)
LOLO . . T o
e 1 | | O L a
O 10 Q (o} o i Q
aval A 5| g2 J a
(SR e) T a k=] & .
1T 19 ! | Y 1 a |
Y =T m (&} Iz | |9}
dzad & ¢ 3t 4 8
nAAL @ [0 oo 9 3
9905 8 6 08 g
RIRIREAL ® 8 o &
m
m 0
2 4 slelzlz] e = HEIRE:] g
9 - Bl3lele| = 2 2le = g
2 m
M .
. m
m +
T
] 9
2
T 0100A g:“g I
] G
0I20A
4 aé ano|
79| w00 R ano [T
T 300A I o7
7| 3w00n ol
- T ] Tdn N9
s o N aNoy T Ii
L g g w B s 8 5
g & Bs B & g g &8
-
54 o 8 g b el
s %" %
— [I 8
38 m E 2 .
s m Q—L“‘ N
+ g 3 |
’—15 I &
82 O @
Bl s — M
m L @
5 Riaian i o aZ
@ Al gk a o) m e
— m v il > O 2
+ T 2 a 2
{ o m © =
Tt m L E
+ I
38 28

USB+5V

28
28

USB+5V
o

I
19118182-2RDILF

Figure 10c. MAX1121X EV Kit Schematic (Sheet 3 of 6)
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Figure 10d. MAX1121X EV Kit Schematic (Sheet 4 of 6)
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Figure 10f. MAX1121X EV Kit Schematic (Sheet 6 of 6)
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Figure 11. MAX1121X EV Kit Component Placement Guide—Top Side
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Figure 12. MAX1121X EV Kit PCB Layout—Layer 1
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Figure 13. MAX1121X EV Kit PCB Layout—Layer 2
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Figure 14. MAX1121X EV Kit PCB Layout—Layer 3
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Figure 15. MAX1121X EV Kit PCB Layout—Layer 4
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Figure 16. MAX1121X EV Kit PCB Layout—Layer 5
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Figure 18. MAX1121X EV Kit Component Placement Guide—Bottom Side
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MAX1121X Family Evaluation Kit

Component List

Refer to file “evkit_ bom_max1121X_evkit_a.csv” attached
to this data sheet for component information.

www.maximintegrated.com

Evaluates: MAX11214/MAX11216

Ordering Information

PART TYPE
MAX11214EVKIT# EVKIT
MAX11216EVKIT# EVKIT

#Denotes RoHS compliant.
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MAX1121X Family Evaluation Kit Evaluates: MAX11214/MAX11216

Revision History

REVISION | REVISION PAGES
NUMBER DATE DESCRIPTION CHANGED
0 4/15 Initial release —

For pricing, delivery, and ordering information, please contact Maxim Direct at 1-888-629-4642, or visit Maxim Integrated’s website at www.maximintegrated.com.

Maxim Integrated cannot assume responsibility for use of any circuitry other than circuitry entirely embodied in a Maxim Integrated product. No circuit patent licenses
are implied. Maxim Integrated reserves the right to change the circuitry and specifications without notice at any time.

Maxim Integrated and the Maxim Integrated logo are trademarks of Maxim Integrated Products, Inc. © 2015 Maxim Integrated Products, Inc. | 34




		TITLE: Bill of Materials																

		DATE: 09/24/2014																

		DESIGN: max11214/216_revA																

		ITEM		QTY		REF DES		MFG PART #		MANUFACTURER		VALUE		DESCRIPTION				

		1		14		 +5V,+10V,+1.8V,+2.0V,+2.5V,+3.3V,-1.8V,A3.6V,D3.6V,+10VEXT,+15VEXT,-15VEXT,-10V,AVDD		5005		?		N/A		TESTPOINT WITH 1.80MM HOLE DIA, RED, COMPACT; NOT FOR COLD TEST				

		2		5		G1,G3,G4,G2,G5		5006		?		N/A		TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.35IN; BOARD HOLE=0.063IN; BLACK; PHOSPHOR BRONZE WIRE SILVER PLATE FINISH; RECOMMENDED FOR BOARD THICKNESS=0.062IN; NOT FOR COLD TEST				

		3		30		DAC+,DAC-,BUFF_OUT,BUFF_OUT1,BUFF_OUT2,IN+,IN-,TP2,AVSS,CH_A+,CH_A-,CH_B+,CH_B-,CH_C+,CH_C-,CH_D+,CH_D-,GPIO1-GPIO3,A_INP1,A_INP2,C_INP1,C_INP2,-10VEXT,ADC_INN,ADC_INP,ADC_CAPR,ADC_REFN,ADC_REFP,EXT_REFN,EXT_REFP		5007		?		N/A		TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.35IN; BOARD HOLE=0.063IN; White PHOSPHOR BRONZE WIRE SILVER PLATE FINISH; RECOMMENDED FOR BOARD THICKNESS=0.062IN; NOT FOR COLD TEST				

		4		15		C1,C2,C8,C10,C25-C27,C34-C37,C43,C53,C60,C70		N/A		?		1UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 1UF; 25V; TOL=10%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=X7R-NOT RECOMMENDED FOR NEW DESIGN-USE 20-0001u-04				

		5		53		C3,C5,C9,C11,C14-C18,C21,C22,C29,C30,C32,C33,C39,C41,C42,C45,C47,C49,C52,C56,C58,C61,C63,C65,C67,C69,C73,C74,C77-C81,C86,C90,C94,C97,C98,CB4,CB5,C101,C103,C110,C111,C113,C119,C123,C128-C130		N/A		?		0.1UF		CAPACITOR; SMT; 0603; CERAMIC; 0.1uF; 25V; 10%; X7R; -55degC to + 125degC;  +/-15% from -55degC to +125degC; NOT RECOMMENDED FOR NEW DESIGN USE - 20-000u1-01				

		6		2		C4,C12		N/A		?		180PF		CAPACITOR; SMT (0603); CERAMIC CHIP; 180PF; 50V; TOL=10%; MODEL=C0G; TG=-55 DEGC TO +125 DEGC; TC=+/				

		7		1		C6		N/A		?		0.47UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 0.47UF; 25V; TOL=10%; MODEL=GRM SERIES; TG=-55 DEGC TO +125 DEGC; TC=X7R				

		8		7		C7,C13,C23,C28,C40,C57,CB1		N/A		?		10UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 10UF; 25V; TOL=10%; MODEL=; TG=-55 DEGC TO +85 DEGC; TC=X5R				

		9		3		C19,C20,C24		N/A		?		4.7UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 4.7UF; 25V; TOL=10%; MODEL=X5R; TG=-55 DEGC TO +125 DEGC; TC=+/				

		10		3		C31,C54,C82		N/A		?		4.7UF		CAPACITOR; SMT (0805); CERAMIC CHIP; 4.7UF; 25V; TOL=10%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=X7R				

		11		24		C38,C44,C46,C48,C50,C55,C62,C64,C68,C75,C76,C88,C89,C91,C92,C96,C100,C104,C112,C117,C120,C121,C126,C127		N/A		?		1UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 1UF; 16V; TOL=10%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=X7R				

		12		3		C51,C59,C66		N/A		?		0.047UF		CAPACITOR; SMT; 0603; CERAMIC;  0.047uF; 25V; 10%; X7R; -55degC to + 125degC;  0 +/-15% degC MAX., USE 20-0u047-91 FOR NEW DESIGN				

		13		1		C71		N/A		?		0.001UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 0.001UF; 25V; TOL=20%; MODEL=C SERIES; TG=-55 DEGC TO +125 DEGC; TC=C0G				

		14		1		C72		N/A		?		10PF		CAPACITOR; SMT; 0603; CERAMIC; 10pF; 50V; 5%; C0G; -55degC to + 125degC, USE 20-0010p-E4 FOR NEW DESIGN				

		15		3		C83,C87,C108		N/A		N/A		?		CAPACITOR; 0603 PACKAGE; GENERIC				

		16		10		C84,C85,C99,C102,C105,C107,C118,C122,C124,C125		N/A		?		1000PF		CAPACITOR; SMT; 0603; CERAMIC; 1000pF; 50V; 5%; C0G; -55degC to +125degC, USE 20-1000p-E4 FOR NEW DESIGN				

		17		2		C93,C109		N/A		?		0.01UF		CAPACITOR; SMT (0603); CERAMIC CHIP; 0.01UF; 25V; TOL=5%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=C0G				

		18		3		C95,CB6,C115		N/A		?		0.01UF		CAPACITOR; SMT (0603); CERAMIC; 0.01UF; 16V; TOL=10%; MODEL=GRM SERIES; TG=-55 DEGC TO +125 DEGC; TC=X7R				

		19		2		C106,C114		N/A		?		1000PF		CAPACITOR; SMT (0603); CERAMIC CHIP; 1000PF; 50V; TOL=1%; MODEL=GRM SERIES; TG=-55 DEGC TO +125 DEGC; TC=C0G				

		20		2		C116,C131		N/A		?		1000PF		CAPACITOR; SMT; 0603; CERAMIC; 1000pF; 50V; 10%; X7R; -55degC to + 125degC;  +/-15% from -55degC to +125degC, USE 20-1000p-E4 FOR NEW DESIGN				

		21		2		CB2,CB3		N/A		?		18PF		CAPACITOR; SMT (0603); CERAMIC CHIP; 18PF; 50V; TOL=5%; MODEL=; TG=-55 DEGC TO +125 DEGC; TC=C0G				

		22		3		D1,D2,DB1		MBR0520L		FAIRCHILD SEMICONDUCTOR		MBR0520L		DIODE, SCHOTTKY, SOD-123, PIV=20V, Vf=0.385V@If=0.5A, If(ave)=0.5A				

		23		1		DS1		LS L29K-G1J2-1-Z		OSRAM		LS L29K-G1J2-1-Z		DIODE; LED; SMART; RED; SMT (0603); PIV=1.8V; IF=0.02A; -40 DEGC TO +100 DEGC				

		24		2		DS2,DSB1		LG L29K-G2J1-24		OSRAM		LG L29K-G2J1-24		DIODE; LED; SMT (0603); Vf=1.7V; If(test)=0.002A; -40 DEGC TO +100 DEGC				

		25		1		J1		10118192-0001LF		FCI CONNECT		10118192-0001LF		CONNECTOR; FEMALE; SMT; MICRO USB B TYPE RECEPTACLE; RIGHT ANGLE; 5PINS				

		26		4		J2,J3,J6,J7		PBC03SABN		SULLINS		PBC03SABN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 3PINS				

		27		9		J4,J5,J8,J21,J23,J36,J40,J44,J45		PBC03SAAN		SULLINS		PBC03SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 3PINS; -65 DEGC TO +125 DEGC				

		28		5		J9,J10,J11-J14		OSTTA020161		ON-SHORE TECHNOLOGY INC.		OSTTA020161		CONNECTOR; FEMALE; THROUGH HOLE; 5MM TERMINAL BLOCK CONNECTOR; STRAIGHT; 2PINS				

		29		4		J15,J20,J37,J46		PCC02SAAN		SULLINS		PCC02SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT THROUGH; 2PINS; -65 DEGC TO +125 DEGC				

		30		1		J16		KLDX-0202-B		KYCON		KLDX-0202-B		CONNECTOR; FEMALE; THROUGH HOLE; DC POWER JACK; RIGHT ANGLE; 3PINS				

		31		2		J17,J18		PBC03DAAN		SULLINS ELECTRONICS CORP.		PBC03DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 6PINS; -65 DEGC TO +125 DEGC				

		32		1		J19		PBC06SAAN		SULLINS ELECTRONICS CORP.		PBC06SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 6PINS; -65 DEGC TO +125 DEGC				

		33		4		J22,J24,J28,J30		PBC02DAAN		SULLINS ELECTRONIC CORP.		PBC02DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 4PINS				

		34		2		J25,J29		PBC04DAAN		SULLINS ELECTRONICS CORP.		PBC04DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 8PINS; -65 DEGC TO +125 DEGC				

		35		5		J31,J34,J38,J41,J42		73391-0060		MOLEX		73391-0060		CONNECTOR; FEMALE; THROUGH HOLE; SMA JACK CONNECTOR; STRAIGHT; 5PINS				

		36		2		J32,J33		TSW-106-08-S-D-RA		SAMTEC		TSW-106-08-S-D-RA		CONNECTOR; THROUGH HOLE; DOUBLE ROW; RIGHT ANGLE; 12PINS; THIS PART IS DEDICATED FOR PMOD PERIPHERAL BOARD				

		37		2		J35,J39		PBC10SAAN		SULLINS ELECTRONICS CORP.		PBC10SAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 10PINS; -65 DEGC TO +125 DEGC				

		38		1		J43		ASP-134604-01		SAMTEC		ASP-134604-01		CONNECTOR; MALE; SMT; HIGH SPEED/HIGH DENSITY OPEN PIN FIELD TERMINAL ARRAY; STRAIGHT; 160PINS				

		39		5		L1-L5		MPZ1608S601A		TDK		600		INDUCTOR; SMT (0603); FERRITE-BEAD; 600; TOL=+/-25%; 1A; -55 DEGC TO +125 DEGC				

		40		1		QB1		2N7002		N/A		2N7002		TRAN; ; NCH; SOT-23; PD-(0.33W); IC-(0.5A); VCEO-(60V); EVKIT PART FOR FORM FACTOR PROJECT				

		41		43		R1,R2,R19,R21-R25,R27,R31,R35,R37,R46-R48,R50-R52,R54,R57-R59,R62,R63,R65,RB7,RB9,RB12,RB14,RB16,RB18,RB19,RB23,RB25,RB26,RB31-RB33,RB35,RB48-RB51		N/A		?		28		RESISTOR; 0603; 28 OHM; 1%; 100PPM; 0.10W; THICK FILM				

		42		7		R3,R5,R18,R38,RB60,RB61,RB64		N/A		?		100K		RESISTOR; 0603; 100K; 1%; 100PPM; 0.10W; THICK FILM				

		43		2		R4,R8		N/A		?		715K		RESISTOR; 0603; 715K OHM; 1%; 100PPM; 0.10W; METAL FILM				

		44		4		R6,R7,RB1,RB2		N/A		?		1K		RESISTOR; 0603; 1K; 1%; 100PPM; 0.10W; THICK FILM				

		45		8		R9,R32,R64,R73,RB27-RB30		N/A		?		0		RESISTOR; 0603; 0 OHM; 0%; JUMPER; 0.10W; THICK FILM				

		46		2		R10,R11		N/A		?		6.04K		RESISTOR; 0603; 6.04K; 1%; 100PPM; 0.10W; THICK FILM				

		47		1		R12		N/A		?		150K		RESISTOR, 0603, 150K OHM,1%, 100PPM, 0.10W, THICK FILM				

		48		2		R13,R14		N/A		?		453K		RESISTOR; 0603; 453K OHM; 1%; 100PPM; 0.10W; THICK FILM				

		49		4		R15-R17,R26		N/A		?		237K		RESISTOR; 0603; 237K OHM; 1%; 100PPM; 0.10W; THICK FILM				

		50		1		R20		N/A		?		169K		RESISTOR; 0603; 169K OHM; 1%; 100PPM; 0.10W; THICK FILM				

		51		1		R28		N/A		?		105K		RESISTOR; 0603; 105K OHM; 1%; 100PPM; 0.10W; THICK FILM				

		52		38		R29,R30,R33,R36,R40-R43,R56,R60,R66-R69,R74,R76,R77,R79,RB5,RB6,RB8,RB11,RB13,RB15,RB20-RB22,RB24,RB38-RB40,RB42,RB44,RB53-RB55,RB57,RB59		N/A		?		10K		RESISTOR; 0603; 10K; 1%; 100PPM; 0.10W; THICK FILM				

		53		1		R34		N/A		?		10		RESISTOR; 0603; 10 OHM; 5%; 200PPM; 0.10W; THICK FILM				

		54		1		R39		N/A		?		100		RESISTOR; 0603; 100 OHM; 5%; 200PPM; 0.10W; THICK FILM				

		55		3		R44,RB43,RB47		N/A		?		10		RESISTOR; 0603; 10 OHM; 1%; 100PPM; 0.10W; THICK FILM				

		56		1		R45		N/A		?		39K		RESISTOR, 0603, 39K OHM, 1%, 100PPM, 0.10W, THICK FILM				

		57		11		R49,R55,R72,R75,R78,R80,R83-R85,RB45,RB46		N/A		?		49.9		RESISTOR; 0603; 49.9 OHM; 1%; 100PPM; 0.10W; THICK FILM				

		58		4		R53,R61,R70,R71		N/A		?		0		RESISTOR; 0603; 0 OHM; 5%; JUMPER; 0.063W; THICK FILM				

		59		2		R81,R82		N/A		?		4.99		RESISTOR; 0603; 4.99 OHM; 1%; 100PPM; 0.1W; THICK FILM				

		60		1		RB3		N/A		?		12K		RESISTOR, 0603, 12K OHM, 1%, 100PPM, 0.10W, THICK FILM				

		61		1		RB4		N/A		?		15K		RESISTOR, 0603, 15K OHM,1%, 100PPM, 0.10W, THICK FILM				

		62		1		RB10		N/A		?		2.2K		RESISTOR, 0603, 2.2K OHM, 1%, 100PPM, 0.10W, THICK FILM				

		63		1		RB17		N/A		?		4.7K		RESISTOR; 0603; 4.7K; 1%; 100PPM; 0.10W; THICK FILM				

		64		8		RB34,RB36,RB37,RB41,RB52,RB56,RB63,RB65		N/A		?		1M		RESISTOR; 0603; 1M; 1%; 100PPM; 0.10W; THICK FILM				

		65		3		RB58,RB62,RB66		N/A		?		100		RESISTOR; 0603; 100 OHM; 1%; 100PPM; 0.10W; THICK FILM				

		66		2		SYNC_CLK_IN,SYNC_CLK_OUT		5123		?		N/A		TEST POINT; PIN DIA=0.125IN; TOTAL LENGTH=0.35IN; BOARD HOLE=0.063IN; GRAY; PHOSPHOR BRONZE WIRE SILVER PLATE FINISH; RECOMMENDED FOR BOARD THICKNESS=0.062IN; NOT FOR COLD TEST				

		67		1		T1		TGM-H240V8LF		HALO ELECTRONICS, INC		TGM-H240V8LF		TRANSFORMER; SMT; 1:1:1.3:1.3; DC/DC CONVERTER				

		68		2		U1,U4		BAS4002A-RPP		INFINEON		BAS4002A-RPP		DIODE; SCH; LOW VF SCHOTTKY DIODE ARRAY; SMT (SOT-143); PIV=40V; IF=0.2A				

		69		3		U2,U5,U11		MAX15006CATT+		MAXIM		MAX15006CATT+		IC; VREG; ULTRA-LOW QUIESCENT-CURRENT LINEAR REGULATOR; TDFN6-EP 3X3				 MAX15006CATT+

		70		1		U3		MAX13256ATB+		MAXIM		MAX13256ATB+		IC; DRV; 36V H-BRIDGE TRANSFORMER DRIVER FOR ISOLATED SUPPLIES; TDFN10-EP 3X3				 MAX13256ATB+

		71		1		U6		MAX15006BATT+		MAXIM		MAX15006BATT+		IC; VREG; ULTRA-LOW QUIESCENT-CURRENT LINEAR REGULATOR; TDFN6-EP 3X3				 MAX15006BATT+

		72		4		U7-U9,U13		MAX8842ELT+		MAXIM INTEGRATED		MAX8842ELT+		IC; VREG; ULTRA-LOW-NOISE; HIGH PSRR; LOW-DROPOUT; LINEAR REGULATOR; UDFN6 1.5MM X 1.0MM				 MAX8842ELT+

		73		2		U10,U21		MAX6126AASA25+		MAXIM		MAX6126AASA25		IC; SERIES VOLTAGE REFERENCE; ULTRA HIGH PRECISION; ULTRA LOW NOISE VOLTAGE REFERENCE; SOIC8 150MIL; Vout=2.5V, 3ppm/degC max TEMPCO				 MAX6126AASA25+

		74		2		U12,UB1		93LC66BT-I/OT		MICROCHIP		93LC66BT-I/OT		IC; EPROM; 4K MICROWIRE SERIAL EEPROM; SOT23-6				

		75		1		U14		MAX15006AATT+		MAXIM		MAX15006AATT+		IC; VREG; ULTRA-LOW QUIESCENT-CURRENT LINEAR REGULATOR; TDFN6-EP 3X3				 MAX15006AATT+

		76		1		U15		MAX542AESD+		MAXIM		MAX542AESD+		IC; DAC; SERIAL-INPUT, VOLTAGE-OUTPUT, 16-BIT DAC; NSOIC14 150MIL				 MAX542AESD+

		77		3		U16-U18		MAX9632AUA+		MAXIM		MAX9632AUA+		IC; OPAMP; PRECISION, LOW-NOISE, WIDE-BAND AMPLIFIER; UMAX8 ; -40 DEGC TO +125 DEGC				 MAX9632AUA+

		78		1		U19		MAX664ESA		MAXIM		MAX664ESA		IC, NEGATIVE VOLTAGE REGULATOR, DUAL MODE, 5V/PROGRAMMABLE, 2V TO 16.5V INPUT VOLTAGE RANGE,VS(MAX)=-18V, SOIC8-150MIL, -40degC TO +85degC				 MAX664ESA

						Note:  U20 varies depending on the EVKIT.  MAX11214EVKIT ships with FXO-HC730-4.096.  MAX11216EVKIT ships with FXO-HC730-8.192.  												

		79		1		U20		FXO-HC730-8.192		FOX		FXO-HC730-8.192		OSCILLATOR; SMT 5X7; HCMOS; 8.192MHZ; NO DATA; +/-100PPM				

		79		1		U20		FXO-HC730-4.096		FOX		FXO-HC730-4.096		OSCILLATOR; SMT 5X7; HCMOS; 4.096MHZ; NO DATA; +/-100PPM				

		80		3		U22,U29,U34		MAX14934FAWE		MAXIM		MAX14934FAWE		IC; DISO; LOW POWER QUAD CHANNELS DIGITAL ISOLATOR; WSOIC16 300MIL				

		81		4		U23,U24,U26,U27		MAX44241AUK+		MAXIM 		MAX44241AUK+		IC; OPAMP; LOW NOISE; PRECISION; SINGLE OP AMPS; SOT23-5				 MAX44241AUK+

						Note:  U25 varies depending on the EVKIT.  MAX11214EVKIT ships with MAX11214EUG+.  MAX11216EVKIT ships with MAX11216EUG+.  												

		82		1		U25		MAX11216EUG+		N/A		MAX11216EUG+		EVKIT PART-IC; ADC; SINGLE CHANNEL MEDIUM SPEED DELTA-SIGMA ADC WITH SPI INTERFACE; TSSOP24				

		82		1		U25		MAX11214EUG+		N/A		MAX11214EUG+		EVKIT PART-IC; ADC; SINGLE CHANNEL MEDIUM SPEED DELTA-SIGMA ADC WITH SPI INTERFACE; TSSOP24				

		83		2		U28,U30		74LVC2G125DP		?		74LVC2G125DP		IC; DRV; DUAL BUS BUFFER/LINE DRIVER; 3-STATE; TSSOP8				

		84		1		UB2		FT2232HL		FUTURE TECHNOLOGY DEVICES INTL LTD.		FT2232HL		IC; MMRY; DUAL HIGH SPEED USB TO MULTIPURPOSE UART/FIFO; LQFP64				

		85		1		UB3		MAX3002EUP		MAXIM		MAX3002EUP		IC, TRANS, 8-CHANNEL LEVEL TRANSLATOR, 20Mbps, ESD-PROTECTED				 MAX3002EUP

		86		1		YB1		ABM7-12.000MHZ-D2Y-T		ABRACON		12MHZ		CRYSTAL; SMT ; 18PF; 12MHZ; +/-20PPM; +/-30PPM				

		87		2		J26,J27		PBC05DAAN		SULLINS ELECTRONICS CORP.		PBC05DAAN		CONNECTOR; MALE; THROUGH HOLE; BREAKAWAY; STRAIGHT; 10PINS; -65 DEGC TO +125 DEGC				

		15		2		D3, D4		BAT54S		FAIRCHILD SEMICONDUCTOR		BAT54S		DIODE; SCH; SCHOTTKY DIODE; SMT (SOT-23); PIV=30V; IF=0.2A				

																		

		88		1		 		123		MAXIM		 PCB		 PCB: 123				

		TOTAL		436														

																		

		DO NOT PURCHASE(DNP)																

		ITEM		QTY		REF DES		MFG PART #		MANUFACTURER		VALUE		DESCRIPTION				

		TOTAL		0														



